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Introducere

O sursă de date, sau o bază de date, este o colecţie de informaţii care pot fi accesate şi 
prelucrate de OpenOffice.org (OOo). De exemplu, o listă de nume şi adrese este o sursă de 
date care poate fi folosită pentru a produce o scrisoare. Inventarul unui magazin poate fi 
prelucrat prin OOo.

Notă OpenOffice.org foloseşte termenii "Sursă de date" (“Data Source”) şi "Bază de date" 
(“Database”) pentru a se referi la acelaşi lucru, care poate fi o bază de date ca 
MySQL sau dBase sau o foaie de calcul ori un document text în care se găsesc date.

Acest capitol este doar o introducere în folosirea surselor de date. Pentru mai multe informaţii 
consultaţi Ghidul bazelor de date.

Acest capitol explică crearea unei baze de date, vizualizarea a ceea ce este conţinut în aceasta 
şi cum foloseşte OOo diferitele componente. Explică de asemenea cum să folosiţi componenta 
Base din OOo pentru a lucra şi cu alte surse de date. O sursă de date înseamnă o baza de date, 
o foaie de calcul sau un document text.

Aten ieţ

   

Bazele de date din OOo necesită Java JRE de la Sun. Daca aceste progarme nu sunt 
instalate pe calculatorul dumneavoastră atunci va rog să le descarcaţi de la 
www.java.com şi să le instalaţi (instrucţiuni găsiţi pe acel site). În OOo, folosiţi 
Unelte > Opţiuni > OpenOffice.org > Java (Tools > Options > OpenOffice.org > 
Java) pentru a configura Java.

Crearea unei baze de date

În acest exemplu, vom parcurge paşii necesari creării unei noi baze de date. Aceasta va conţine 
două agende: una pentru cunoştinţe şi alta pentru rude, şi două secţiuni cu informaţii, una 
pentru cunoştinţe şi cealaltă pentru rude.

Crearea unei noi baze de date

Imaginea 1: Crearea unei noi baze de date.

Ini iere în Baseţ 1
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Pentru a crea o nouă bază de date apăsaţi pictogramă Nou (New). În meniul derulant selectaţi 
Bază de date (Database) (Imaginea 1). Aceasta va deschide Vrăjitorul de baze de date. Puteţi 
deschide Vrăjitorul şi de la Fişier > Nou > Bază de date (File > New > Database).

Primul pas din Vrăjitor pune o întrebare cu două răspunsuri: Crearea unei noi baze de date 
(Create a new database) sau Conectarea la o bază de date existentă (Connect to an 
existing database). În acest exemplu veţi selecta Crearea unei noi baze de date (Create a 
new database şi apoi apăsaţi Următorul (Next).

La al doilea pas sunt două întrebări, fiecare cu câte doua răspunsuri. La prima întrebare este 
deja selectat Da, înregistrează baza de date pentru mine (Yes, register the database for 
me) iar la a doua Deschide baza de date pentru editare (Open the database for editing). 
Verificaţi că sunt alese aceste două răspunsuri şi apăsaţi Finalizare (Finish).

Notă Dacă baza de date nu este înregistrată nu va fi accesibilă pentru alte componente ca 
Writer sau Calc. Dacă aceasta este înregistrată va putea fi accesată de alte componente.

Salvaţi noua bază de date cu numele Information. Aceasta va deschide fereastra Information – 
OpenOffice.org. 

PONT De fiecare dată când deschideţi baza de date Information se va deschide şi fereastra 
Information –  OpenOffice.org Base. Puteţi astfel efectua modificări în baza de date.

Crearea tabelelor din baza de date

Notă Într-o bază de date, un tabel reprezintă informaţia despre un frup de lucruri. De 
exemplu, un tabel poate să conţină o agendă cu adrese, lista de inventar, cartea de 
telefon sau lista preţurilor. O bază de date poate avea de la unul la mai multe tabele.

Când se deschide fereastra Information – OpenOffice.org Base este selectat Formulare 
(Forms). Apăsaţi Tabele (Tables) pentru a selecta, după cum se vede în Imaginea 2. Vom crea 
tabelul Acquaintance Addressses (Adrese de cunoştinţe) folosind Vrăjitorul de tabele (Table 
Wizard) şi tabelul Acquaintance Information (Informaţii despre cunoştinţe) folosind modul de 
lucru Design Mode. Vom crea tabelele Relatives Addresses (Adrese de rude) şi Information 
(Informaţii) prin copiere.

Similar, ambele tabele Information au câteva câmpuri conţinând lunile anului. Creând şi un 
tabel cu lunile anului ne vom uşura munca atunci când vom introduce datele în foecare 
formular. Aceasta se va observa după crearea formularelor. (Acest tabel va fi numai o sursă de 
date pentru lista care va fi inserată în cele două formulare de Informaţii pe care le vom crea, 
astfel încât să nu fie necesar să creem formulare suplimentare.)

Ini iere în Baseţ 2
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Imaginea 2: Crearea tabelelor.

Folosirea Vr jitorului pentru a crea un tabelă

Aten ieţ

   

Fiecare tabel include obligatoriu un câmp, Cheie primară (Primary key). (La ce 
foloseşte acesta va fi explicat mai târziu.) Vom folosi acest câmp pentru a numerota 
înregistrările şi dorim ca acest câmp să fie mărit în mod automat pe măsură ce 
adăugăm înregistrări. În acest moment această opţiune nu este posibilă în cadrul 
Vrăjitorului. Numai tabelele create în modul Design vor avea această facilitate. 
Există în Vrăjitor o opţiune, Autovaloare (Auto value) dar aceasta nu este încă 
funcţională. (Vedeţi pasul 3: Crearea cheii primare, mai jos.)

Primul tabel pe care îl vom crea: o agendă cu adresele cunoştinţelor.

Apăsaţi Foloseşte Vrăjitorul pentru a crea un tabel (Use Wizard to Create Table). Aceasta va 
deschide Vrăjitorul de tabele. 

Notă Un câmp dintr-un tabel reprezintă o unitate de informaţie. De eexemplu, într-un tabel 
conţinând o listă de preturi, probabil vor fi un câmp cu numele produsului, un altul 
pentru descrierea produsului şi un al treilea pentru preţ. Pot fi adăugate mai multe 
câmpuri, după cum aveţi nevoie.

Pasul 1: Alegerea câmpurilor.

Sunt prezentate două categorii de tabele: Afaceri (Business) şi Privat (Personal). Fiecare 
categorie conţine mai multe tabele, fiecare având predefinite câmpurile folosite uzual; dintre 
acestea puteţi alege dumneavoastră. Fiecare tabel are o listă de câmpuri disponibile, si vom 
folosi tabelul Adrese (Addresses) din categoria Personal pentru a selecta câmpurile care ne sunt 
necesare.

• Categoria (Category): Selectaţi Personal. Lista derulantă Exemple de tabele (Sample 
Tables) se va modifica, prezentând o listă de tabele pentru folosinţă personală.

• Exemple de tabele (Sample Tables): Selectaţi Addresses (Adrese). Fereastra Câmpuri 
disponibile (Available fields) va afişa câmpurile disponibile din acest tabel.

• Câmpuri selectate (Selected Fields): Folosind butonul > mutaţi aceste câmpuri din 
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fereastra Câmpuri disponibile (Available fields) către fereastra Câmpuri selectate 
(Selected fields) în această ordine: AddressID, FirstName, LastName, SpouseName, 
Address, City, StateOrProvince, PostalCode, CountryOrRegion, PhoneNumber, 
MobileNumber (telefonul mobil) şi EmailAddress.

• Dacă nu le veţi copia în ordinea prescrisă, atunci apăsaţi pe numele câmpului pentru a-l 
selecta. Folosiţi apoi săgeţile Sus (Up) sau Jos (Down) din partea dreaptă a ferestrei 
Câmpuri selectate pentru a muta numele câmpului în ordinea dorită.

• Apăsaţi Următorul (Next).

Pasul 2: Stabiliţi tipurile câmpurilor şi formatele.

În acest pas veţi stabili caracteristicile câmpurilor. Pe măsură ce fiecare câmp este selectat se 
va schimba informaţia afişată în partea dreaptă. Puteţi efectua astfel schimbările dorite. (Vedeţi 
Imaginea 3.)

Sub fereastra Câmpuri selectate sunt două butoane: unul cu semnul + şi celălalt cu semnul –. 

Aten ieţ

   

Aceste butoane sunt folosite pentru a adăuga sau a şterge câmpurile din fereastra 
Câmpuri selectate. Fiţi atent când le folosiţi până vă veţi obişnui cu crearea tabelelor.

Pe partea dreaptă a ferestrei Câmpuri selectate sunt două butoane: o săgeată sus (up) şi alta jos 
(down). Acestea mută câmpul selectat în sus sau în jos.

Imaginea 3: Schimbarea tipurilor câmpurilor (Field Types).

Notă Dacă în vreunul dintre aceste câmpuri nu este obligatoriu să se introducă date, atunci 
setaţi caracteristica Completare necesară (Entry required) la Nu (No). Daca aceasta 
va fi stabilită ca "da (yes)", atunci va trebui să conţină ceva. Dacă de exemplu câmpul 
FirstName va avea această caracteristică pozitivă nu vă va fi permis să aveţi o 
înregistrare din care să lipsească acest câmp (care este intenţionat să conţină numele 
de familie). Aşadar, stabiliţi Completare necesară (Entry required) la Da (Yes) 
numai dacă ceva trebuie întotdeauna pus în acel câmp.

• AddressID: Nu modificaţi nimic.

• FirstName (Nume de familie): 

• Entry required (Completare necesară): Am discutat această problemă în cadrul notei de 
mai sus. Dacă va fi întotdeauna necesar ca acest câmp să conţină ceva atunci stabiliţi 
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aceasta caracteristică la da (yes), altfel la nu (no). 

• Length (Lungime): Sugestie: Schimbaţi Length la 20. Aceasta va fi acoperitoare pentru 
orice nume de familie (FirstName) pe care îl veţi introduce. Puteţi introduce şi mai 
puţin dacă sunteţi sigur că va fi de ajuns.

Notă În Base lungimea maximă a fiecărui câmp trebuie specificată la crearea acestuia. Nu 
va fi posibil să o schimbaţi mai târziu, aşa că dacă sunteţi nesigur optaţi pentru 
valoarea mai mare.

• LastName (Prenume): Length=20 ar trebui să fie suficient.

• SpouseName (Prenume soţie): Length=20 ar trebui să fie suficient. Entry required ar 
trebui să fie nu (no). (Nu sunt toţi căsătoriţi.)

• Address (Adresa): Schimbaţi Length la 50 cel puţin. Dacă este necesar puneţi o valoare 
şi mai mare.

• City (Localitate): Length=20 ar trebui să fie suficient.

• StateOrProvince (Judeţul): Length pentru acest câmp depinde de adresa memorată. În 
Statele Unite, o lungime de 2 este suficient. În România puteţi să memoraţi judeţele fie 
prin prescurtarea de 2 litere fie prin denumirea completă, caz în care va trebui să vedeţi 
numărul maxim de caractere (litere + spaţii) din denumire.

• PostalCode (Cod poştal): Length va trebui să permită stocarea codului poştal al 
persoanei respective, şi depinde de la zonă la zonă. Chiar şi în Statele Unite, în unele 
zone se folosesc numai 5 cifre (#####) iar în altele 9 (#####-####). Acestea necesită o 
lungime de 5 şi respectiv 9.

• CountryOrRegion (Ţara sau regiunea): Entry required ar trebui să fie nu (no). Folosiţi o 
lungime adecvată.

• PhoneNumber (Numărul de telefon): Entry required va trebui să fie nu (no). Stabiliţi 
lungimea după nevoi, având grijă să număraţi toate caracterele: cifre, spaţii, paranteze, 
cratime, etc. De exemplu, (555) 333-2222 implică Length = 14. Dacă numărul de 
telefon include un interior număraţi şi caracterele necesare acestuia.

• MobileNumber (Telefonul mobil): Procedaţi ca şi la numărul de telefon fix. Aveţi grijă să 
fie suficient spaţiu şi pentru memorarea unui număr de pager.

• EmailAddress (Adresă email): Singura schimbare va fi să stabiliţi Entry required la nu 
(no). Mai sunt şi oameni fără adresă de email.

Când aţi terminat apăsaţi Următorul (Next).

Notă Fiecare câmp are o caracteristică numită Tipul câmpului (Field Type). În Base aceasta 
va trebui să fie specificată. Aceste tipuri pot fi text, numere întregi (integer), date şi 
numere reale (decimal). Dacă în câmp se va memora informaţie generală (de exemplu 
un nume sau o descriere) atunci veţi folosi tipul text. Dacă în câmp se va stoca 
totdeauna un număr (de exemplu un preţ) tipul va trebui să fie unul numeric (decimal 
sau alt tip numeric). Vrăjitorul va alege tipurile potrivite, aşa încât puteţi să vedeţi ce a 
ales acesta pentru a vă face o idee despre ce aveţi nevoie.
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Pasul 3: Stabilirea cheii primare (primary key).

1) Trebuie să bifaţi Crează o cheie primară (Create a  primary key). 

2) Selectaţi opţiunea Foloseşte un câmp existent drept cheie primară (Use an existing field 
as a primary key).

3) În lista derulantă Nume câmp (Fieldname), selectaţi AddressID.

4) Bifaţi Auto value.

5) Apăsaţi Următorul (Next).

Notă O cheie primară identifică în mod unic un element (o înregistrare) din tabel. De 
exemplu, s-ar putea să cunoaşteţi doi oameni numiţi “Randy Herring” sau trei oameni 
domiciliind la aceeaşi adresă şi în cadrul bazei de date vreţi să-i puteţi distinge.

Cea mai simplă metodă este de a atribui fiecăruia un număr unic: numerotăm prima 
persoană cu 1, a doua cu 2 şamd. Fiecare înregistrare va avea un număr unic, astfel 
încât putem spune "înregistrarea ID 172”. Aceasta este şi opţiunea aleasă aici: address 
ID nu are nimic de a face cu domiciliul, este doar un număr atribuit automat de catre 
Base fiecărei înregistrări.

Sunt căi mult mai complexe pentru a face aceasta, răspunzând la întrebarea "Cum pot 
să fiu sigur că fiecare înregistrare din baza de date poate fi identificată în mod unic?".

Pasul 4: Crearea tabelului.

1) If desired, rename the table at this point. If you rename it, make the name meaningful to 
you. For this example, rename the table to Relative Addresses. 

2) Leave the option Insert data immediately checked. 

Apăsaţi Finalizare (Finish) pentru a finaliza vrăjitorul de tabele. Închideţi fereastra deschisă 
de vrăjitor. Veţi ajunge din nou pe fereastra principală a bazei de date, unde sunt listate 
tabelele, interogările, formularele şi rapoartele.

Crearea tabelului prin copierea unui tabel existent

Aici vom crea un al doilea tabel, care va constitui cartea de adrese pentru cunoştinţe. Din 
moment ce tabelul Acquaintance Addresses (Adresele cunoştinţelor) este similar cu Relative 
Addresses (Adresele rudelor), îl vom crea făcând o copie a tabelului Relative Addresses pe care 
o vom modifica.

1) Apăsaţi pe pictograma Tabele (Tables) din panoul Baze de date (Database) pentru a 
vizualiza tabelele existente.

2) Daţi clic dreapta pe pictograma tabelului Relative Addresses. Selectaţi Copiere (Copy) 
din meniul contextual. 

3) Mutaţi pointerul mausului dedesubtul acestui tabel, daţi clic dreapta, şi selectaţi Lipire 
(Paste) din meniul contextual. Va apare fereastra Copiere tabel (Copy table).

4) Schimbaţi numele tabelului în Acquaintance Addresses Table şi apăsaţi Următorul 
(Next).

Ini iere în Baseţ 6
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5) Apăsaţi butonul >> pentru a muta toate câmpurile (Fields) din fereastra stângă în cea 
dreaptă şi apăsaţi Următorul (Next).

6) Din moment ce toate câmpurile (Fields) au deja indicat tipul fiecăruia şi formatarea 
corespunzătoare (File Type) nu sunt necesare modificări. Însă, aici este locul şi 
momentul pentru a efectua asemenea modificări, daca sunt necesare. (Vedeţi 
avertismentul Atenţie (Caution) de mai jos pentru a afla de ce.)  Apăsaţi Creare 
(Create). Este creat noul tabel.

Aten ieţ

   

După ce tabele au fost create cu vrăjitorul, editarea lor este limitată. Cheia primară 
(Primary key) nu poate fi schimbată în nici un fel.  Este posibil să adaugaţi noi 
câmpuri sau să ştergeţi câmpuri. Este posibil să schimbaţi tipul unui câmp atât la 
creare, cât şi mai târziu, în afară de câmpul cheii primare. După ce aţi adăugat date 
în bază, ştergerea câmpurilor va antrena şi ştergerea datelor. Când creaţi un tabel 
nou va trebui să fiţi atenţi să creaţi câmpurile cu numele, lungimea şi formatul 
datelor corecte înainte de a adăuga date.

Crearea tabelelor în modul Concep ie (Design View)ţ
Modul de vizualizare Concepţie (Design View) este o metodă avansată pentru crearea unui nou 
tabel. Vă permite să introduceţi în mod nemijlocit informaţii despre fiecare câmp în tabel.

Notă Deşi Tipul câmpului (Field type) şi Formatarea (Formatting) sunt diferite în Design 
View, conceptele sunt aceleaşi ca în Vrăjitor.

Ambele tabele Acquaintance Information şi Relative Information vor fi create cu această 
metodă. Ambele tabele folosesc aceleaşi câmpuri: ID, FirstName, LastName, SpouseName, 
WedDateM (luna căsătoriei), WedDateD (data căsătoriei), WedDateY (anul căsătoriei), Ch1 
(copilul cel mai vârstnic), Ch1BDM (luna de naştere pentru Ch1), Ch1BDD (ziua de naştere 
pentru Ch1), şi Ch1BDY (anul de naştere pentru Ch1). 

PONT În acest exemplu vom presupune că există numai câte un copil în fiecare familie. 
Câmpuri adiţionale pot fi create în aceste tabele pentru rudele şi cunoştinţele cu mai 
mult de un copil. Acestea vor fi create în aceeasi ordine ca cele de mai sus, de 
exemplu pentru al doilea copil vor fi create Ch2, Ch2BDM, Ch2BDD, şi Ch2BDY. 

Dacă veţi prefera ca numărul zilei să preceadă luna, ca de exemplu 1 Ianuarie în loc 
de Ianuarie 1, puneţi fiecare câmp care conţine ziua înaintea câmpului corespunzător 
ce conţine luna. De exemplu, puneţi WedDateD înaintea WedDateM şi Ch1BDD 
înaintea Ch1BDM.

1) Apăsaţi Creare tabel în modul Concepţie (Create Table in Design View).

2) Completaţi Numele câmpului (Field Name) în prima coloanaă. Folosiţi lista de mai sus, 
şi adăugaţi şi alte câmpuri dacă aveţi nevoie.

3) Selectaţi Tipul câmpului (Field Type) în coloana secundă. Apăsarea pe celule afişează o 
listă cu toate tipurile de câmp disponibile, din care puteţi alege. ID trebuie să fie 
Integer[INTEGER], iar toate celelalte câmpuri a căror denumire se termină în D sau Y 
vor trebui să fie de tipul Small Integer[SMALLINT]. Celelalte câmpuri vor trebui să 
rămână Text[VARCHAR].
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4) Schimbaţi secţiunea Caracteristicile câmpului (Field Properties) de jos. Schimbând 
AutoValue din Nu (No) în Da (Yes) schimbă această secţiune după cum se vede în 
Imaginea 4.

Imaginea 4: Secţiunea Caracteristicile câmpului (Field Properties) (AutoValue)

5) Ajustaţi Caracteristicile câmpului (Field Properties) din zona din partea de jos a 
ferestrei (Imaginea 5). Sugestie: stabiliţi Lungime (Length) la 20 pentru toate câmpurile 
de tipul Text[VARCHAR].

Imaginea 5: Secţiunea Caracteristicile câmpului (Field Properties)

Pentru a accesa opţiuni de formatare suplimentare, apăsaţi pe butonul din dreapta 
câmpului Exemplu de formatare (Format example); butonul are acelaşi nume cu câmpul 
de lângă el

6) Stabiliţi cheia primară. Amintiţi-vă că aceasta reprezintă un număr care de obicei 
identifică în mod unic fiecare înregistare. dati clic dreapta pe căsuţa gri din stânga 
câmpului ID pentru a afişa meniul contextual, din care ultima opţiune este Cheie 
primară (Primary Key). Selectaţi-o (va fi bifată) pentru a seta câmpul ca şi cheie 
primară. Fiecare tabel are o singură cheie primară.

Notă Cheia primară are un singur scop. Orice nume poate fi folosit pentru acest câmp. Nu 
este necesar să denumiţi câmpul ID.

7) Descriere (Description) poate fi orice, sau îl puteţi lăsa necompletat.

8) Pentru a salva şi a închide tabelul, selectaţi Fişier > Închide (File > Close). Dacă nu a 
fost selectată nici o cheie primară, urmaţi instrucţiunile pentru a crea una. Numele de 
tabel (Table Name) sugerat automat poate fi lăsat nemodificat; în acest exemplu vom 
folosi Acquaintance Information (informaţii despre cunoştinţe) ca nume de tabel.

Cel de al patrulea tabel, Relative Information (Informaţii despre rude), este creat urmând 
aceiaşi paşi ca la crearea tabelului Acquaintance Information. 

PONT Dacă doriţi ca câmpul ce conţine cheia primară din tabelul Relative Information să fie 
setat ca Autovaloare (Autovalue), creaţi întregul tabel aşa cum aţi făcut cu tabelul 
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Acquaintance Information. Altfel, puteţi urma paşii pentru a copia un tabel aşa cum 
sunt indicaţi la pagina 6.

Crearea tabelelor pentru liste

Când aceeaşi informaţie va fi folosită în mai multe câmpuri, concepeţi câte un tabel pentru 
fiecare astfel de informaţie. Fiecare din aceste tabele va avea 2 câmpuri: câmpul cu informaţia 
şi un câmp de ID, în această ordine. 

1) Urmaţi instrucţiunile din “Crearea tabelelor în modul Concepţie (Design View)” de la 
pagina 7. În tabelul pe care îl vom crea, cele 2 câmpuri vor fi name (nume) şi ID. Asiguraţi-
vă că pentru câmpul ID aţi setat AutoValoare (AutoValue) ca fiind Da (Yes), şi de asemenea 
că aţi stabilit câmpul ID ca cheie primară. (Vedeţi Imaginea 6.)

1) Salvaţi tabelul cu numele Months (lună calendaristică).

Imaginea 6: Tabelul în modul Concepţie (Design View)

Not  ă Dacă aveţi de creat câteva tabele cu aceleaşi câmpuri, concepeţi un tabel iar pe 
celelalte obţineţi-le prin copiere şi lipire. (Vedeţi “Crearea tabelului prin copierea
unui tabel existent” la pagina 6.) 

Ad ugarea datelor în tabelul listă ă
Tabelele liste nu necesită un formular, deoarece datele se adaugă direct în tabel. În exemplul 
nostru, adăugaţi lunile anului în câmpul name (nume) al tabelului Months. Selectarea 
AutoValue pentru câmpul AddressID va face ca în acest câmp să fie adăugate în mod automat 
numere consecutive.

Vom folosi abrevierile  pentru lunile calendaristice utilizate şi de Formatare numere 
(Number Format) pentru date calendaristice: Ian., Feb., Mar., Apr., Mai, Iun., Iul., Aug., Sep.,  
Oct., Noi. şi Dec., ca în Imaginea 7.

Imaginea 7: Formatele de dată calendaristică disponibile
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1) În fereastra principală a bazei de date, apăsaţi pe pictograma Tabele (Tables). Dati clic 
dreapta pe Months şi selectaţi Deschide (Open) din meniul contextual (Imaginea 8).

2) Introduceţi numele primei luni în câmpul Name (Nume). (Folosiţi abrevierile pentru 
luni.) Folosiţi Cursor/Săgeată Jos (Down Arrow) pentru a vă deplasa la al doilea rând al 
câmpului Name (Nume). Introduceţi numele celei de a doua luni. Continuaţi până veţi fi 
adăugat toate cele 12 luni.

Notă Câmpul ID conţine <AutoCâmp (AutoField)> până când vă veţi deplasa pe al doilea 
rând. Atunci va deveni 1. Pe măsură ce adăugaţi numele lunilor rând cu rând, 
rqndurile câmpului ID se vor schimba în numere pozitive consecutive.

3) Salvaţi şi închideţi fereastra tabelului.
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Crearea unui formular pentru baza de date
Un formular este o interfaţă pentru adăugarea şi editarea datelor. În loc de o listă de 
înregistrări, un formular poate include text suplimentar, imagini, căsuţe de selecţie şi multe alte 
elemente.

Folosirea Vr jitorului pentru a crea formulareă

Imaginea 8: Componente ale unei Baze de date

Apăsaţi pe Tabele (Tables) în zona Baze de date (Database) ca în Imaginea 8, daţi clic dreapta 
pe un tabel din secţiunea Tabel (Table) din fereastră şi selectaţi Vrăjitorul de formulare 
(Form Wizard) din meniu. (Acest vrăjitor poate fi accesat şi apăsând pe Formulare (Forms) 
din zona Baze de date şi selectând Foloseşte Vrăjitorul pentru a crea un formular (Use Wizard 
to Create Form).)
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Imaginea 9: Vrăjitorul de formulare (Form Wizard)

Pasul 1: Creaţi formularul.

1) Sub Tabele sau interogări (Tables or queries) selectaţi Relative Addresses Table 
(Tabelul Adresele rudelor) din lista derulantă (Imaginea 9). Aceasta crează 
câmpurile din lista Câmpuri disponibile (Available Fields).

2) Din moment ce aceste câmpuri sunt deja în ordinea corectă, apăsaţi >> pentru a 
muta toate aceste câmpuri în lista Câmpuri din formular (Fields in the Form). 

PONT Butoanele săgeată dintre listele Câmpuri disponibile (Available Fields) şi Câmpuri  
din formular (Fields in the Form) mută câmpuri între aceste două ferestre. Butoanele 
sus şi jos din partea dreaptă a ferestrei Câmpuri din formular mută câmpul selectat în 
sus sau în jos.

3) Apăsaţi Următorul (Next).

4) Acest formular nu va avea nici un subformular. Apăsaţi Următorul (Next).

5) Aranjamentul în formular (Arrange Controls): Opţiunile sunt (de la stânga la 
dreapta): Pe coloane - Etichetele la stânga (Columnar-Labels Left), Pe coloane - 
Etichetele deasupra (Columnar- Labels Top), Foaie de calcul (Data Sheet) şi 
Blocuri - Etichetele deasupra (In Blocks-Labels Above). Selectaţi Columnar-Labels 
Top şi apoi apăsaţi Următorul (Next).

6) Modul de introducere a datelor (Set Data Entry): Selecţia implicită. Folosiţi: The 
form is to display all data (Acest formular va afişa toate datele). Apăsaţi Următorul 
(Next).

7) Aplică stilurile (Apply Styles): Fereastra Aplică stilurile (Apply styles) conţine 10 
fundaluri. Selectaţi-l pe cel dorit. Sugestie: Ice Blue. Selectaţi şi Marginea câmpului 
(Field border). Sugestie: 3D look. Apăsaţi Următorul (Next).

PONT Deplasând în jos fereastra Vrăjitorul de formulare (Form Wizard) suficient pentru a 
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fi vizibilă partea de sus a formularului, puteţi vedea cum va arăta un stil uitându-vă la 
aceasta. Selectaţi-le pe rând până găsiţi unul care se potriveşte. Procedaţi în mod 
similar şi pentru Marginea câmpului (Field border).

8) Stabilirea numelui (Set Name): Uneori Nume formular (Form Name) va trebui sa fie 
diferit de Nume tabel (Table Name), de care este legat. Este pe dea-ntregul opţiunea 
dumneavoastră. Sugestie în acest caz: Relative Addresses Form (Formularul pentru 
adresele rudelor). Deoarece vom efectua imediat modificări, selectaţi Modificare 
formular (Modify the Form) sub întrebarea Cum doriţi sa procedaţi după crearea 
formularului (How do you want to proceed after creating the form)? Apăsaţi 
Finalizare (Finish).

Pasul 2: Modificarea formularului.

Vom scurta şi apoi vom muta câmpurile. Formularul final va conţine 4 rânduri. Primul rândul 
va conţine Address ID. Rândul al doilea va conţine FirstName, LastName şi SpouseName. Al 
treilea rând va conţine Address, City, StateOrProvince, PostalCode şi CountryOrRegion. Al 
patrulea rând va conţine PhoneNumber, MobileNumber şi EmailAddress. La sfârşit vom stabili 
şi ordinea parcurgerii câmpurilor cu tasta TAB dacă va fi necesar. 

Notă Când apăsaţi pe un câmp acesta va fi selectat. Are 8 pătrăţele verzi (numite mânere -  
handles) în jurul lui. Folosiţi tasta Control + clic cu mausul pentru a selecta numai 
Câmpul (Field) sau Eticheta (Label) - dar nu ambele. Imaginea 10 arată câmpul 
AddressID Field selectat dar nu şi eticheta AddressID.

Imaginea 10: Câmpul selectat

1) Daţi Control + clic pe câmpul AddressID. Mutaţi pointerul mausului câtre mânerul din 
mijloc de pe partea dreaptă. Va deveni ca în Imaginea 11. Trageţi mânerul către stânga 
pentru a micşora câmpul. Sugestie: Reduceţi mărimea câmpului la jumătate din 
lungimea sa.

Imaginea 11: O singură săgeată

2) Repetaţi aceasta pentru fiecare câmp. Ajustaţi lungimea fiecărui câmp într-un mod 
rezonabil. (De exemplu, câmpul StateOrProvince (Ţară sau judeţ) poate fi scurtat 
considerabil pe când câmpul Address (Adresa) va trebui să rămână aşa cum este.) 

Notă Control + clic pe eticheta câmpului o va selecta doar pe aceasta, şi vă va permite să 
efectuaţi schimbări. (Mai multe detalii despre aceasta sunt de găsit în secţiunea 
despre crearea formularelor în modul Concepţie - Design View Form).
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3) Pentru a muta un câmp şi eticheta sa selectaţi-le cu un clic de maus. Mutaţi pointerul 
mausului în interiorul zonei selectate. Pointerul mausului va arăta ca în Imaginea 12. 
Trageţi zona selectată unde doriţi pe suprafaţa formularului.

Imaginea 12: Săgeată dublă

Notă Ţineţi apăsat butonul stâng al mausului în timp ce trageţi zona selectată.

Aten ieţ

   

Nu folosiţi Control +clic când doriţi să mutaţi un câmp, deoarece veţi muta fie 
numai câmpul fie numai eticheta. Pentru a le muta pe ambele, daţi numai clic cu 
mausul şi apoi le trageţi unde doriţi.

4) Pentru a schimba fundalul formularului daţi clic dreapta pe acesta şi apoi, din meniul 
contextual care va apărea, alegeţi Pagină > Fundal (Page > Background). Culoarea 
poate fi schimbată apăsând pe culoarea dorită. De exemplu, schimbaţi în culoarea 
Orange 4. Apăsaţi OK. 

5) Schimbând câmpul Ca (As) din Culoare (Color) în Imagine (Graphic) puteţi folosi ca 
fundal o imagine dintr-un fişier pe care urmează să îl selectaţi.

Imaginea 13: Formularul de adrese (Addresses)

6) Imaginea finală ar trebui să fie similară cu cea din Imaginea 13. 

7) Dacă vi se par prea mici literele din etichetele câmpurilor puteţi să măriţi fontul. 

 a) Daţi Control+clic pe o etichetă pentru a o selecta.

 b)Daţi clic dreapta pe eticheta selectată. Din meniul contextual selectaţi Control.

 c) Daţi click pe butonul Font pentru a deschide fereastra Font de caracter (Font 
Character). (Imaginea 14) Aici puteţi să schimbaţi fontul, mărimea acestuia, aspectul 
şi efectele aplicate acestuia (pentru acestea din urmă folosiţi categoria Efecte fonturi 
- Font Effects tab). Schimbaţi după cum doriţi.

 d)Repetaţi paşii a), b) şi c) şi pentru celelalte etichete.
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 e) Fonturile pentru câmpuri pot fi schimbate asemănător.

Imaginea 14: Schimbarea caracteristicilor fontului

8) Verificaţi ordinea în care câmpurile sunt parcurse cu tasta TAB. Aceasta ar trebui să fie 
corectă, dar trebuie să verificăm.

 a) Daţi clic pe câmpul AddressID pentru a-l selecta. 

 b)Daţi clic pe pictograma Activation Order de pe panoul Formular (Form). (Vedeţi 
Imaginea 15.)

Imaginea 15: Panoul Formular (Form)

 c) Asiguraţi-vă că ordinea câmpurilor este cea din  Imaginea 18. Dacă un câmp este în 
neregulă dati clic pe el ca să îl selectaţi.

• Dacă este necesar să îl deplasaţi în sus, apăsaţi butonul Mută în sus (Move Up) 
pentru a-l aşeza la locul dorit.

• Dacă este necesar să îl deplasaţi în jos, apăsaţi butonul Mută în jos (Move 
Down) pentru a-l aşeza la locul dorit.

• Când aţi corectat ordinea, apăsaţi OK ca să închideţi fereastra Ordinea TAB (Tab 
Order Window).

 1. Formularul Relative Addresses (Adresele rudelor) este finalizat. Salvaţi şi închideţi 
fereastra OpenOffice.org Writer Relative Addresses pentru a vă reîntoarce la fereastra 
Information – OpenOffice.org Base.

Pentru a crea formularul Acquaintance Addressees (Adresele cunoştinţelor) urmaţi similar cei 9 
paşi pe care i-aţi parcurs pentru a crea formularul Relative Addressees.

Aten ieţ

   

Nu folosiţi metoda copierii şi lipirii pentru a crea noi formulare pe baza celor 
existente. Când este creat un formular se creează şi o legătură între acesta şi baza de 
date pe baza căreia a fost creat. Copiind şi lipind, aceasta legătură este păstrată. 
Fiecărui formular creat trebuie să îi asociaţi o altă bază de date.
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Folosirea Vr jitorului pentru a crea formularele pentru informa iiă ţ
Creaţi formularul Relative Information Form (Informaţii despre rude) în acelaşi mod în care aţi 
creat Relative Addresses Form (Adresele rudelor). Formularul Relative Information conţine 4 
rânduri; rândul 1: AddressID; rândul 2: FirstName, LastName, SpouseName, WedDateM, 
WedDateD, WedDateY; rândul 3: HusBDM, HusBDD, HusBDY, WifeBDM, WifeBDD, WifeBD; 
rândul 4: Child1; rândul 5: Ch1BDM, Ch1BDD, Ch1BDY. 

Notă Dacă doriţi, schimbaţi ordinea câmpurilor lună şi zi în zi şi lună.

1) Scurtaţi lungimea fiecărui câmp aşa cum aţi făcut şi în formularul Relative Addresses.

2) Mutaţi fiecare câmp în poziţia sa din rândul respectiv (Imaginea 16).

Imaginea 16: Formularul pentru informaţii

3) Creaţi listele derulante pentru WedDateM, HisBDM, HerBDM şi Ch1BDM.

 a) Daţi Control+clic pe câmpul WedDateM. Daţi clic dreapta în câmpul WedDateM. 
Selectaţi Înlocuieşte cu > Listă derulantă (Replace with > List box) din meniul 
contextual.

 b)Daţi clic-dreapta în câmpul WedDateM. Selectaţi Control.

 c) Folosind categoria General, găsiţi Derulant (Dropdown) lângă marginea de jos. 
Schimbaţi în Da (Yes).

 d)Folosind categoria Date (Data), schimbaţi setările astfel:

• Câmpul de date (Data Field): WedDateM

• Tipul conţinutului listei (Type of list contents): Tabel (Table)

• Conţinutul listei (List Content): Months

• Legat (Bound field): 1.

 e) Repetaţi aceşti paşi pentru HisBDM, HerBDM şi Ch1BDM.

2) Schimbaţi caracteristicile fontului dacă doriţi. (Vedeţi pasul 7 la pagina  14.)

4) Închideţi fereastra Relative Information - OpenOffice.org Writer. Vă veţi reîntoarce la 
fereastra Information – OpenOffice.org Base.
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5) Creaţi formularul Acquaintance Information (Informaţii despre cunoştinţe) urmând 
aceiaşi paşi ca la crearea formularului Relative Information.

Crearea formularelor în modul Concep ie (Design View)ţ
Această metodă implică folosirea intensă a Controalelor bazei de date (Database Controls) şi a 
Panourilor cu unelte pentru concepţia formularelor bazei de date (Database Form Design 
Toolbars). Aceste tehnici depăşesc scopul acestui document; instrucţiuni pentru crearea 
formularelor folosind modul Concepţie găsiţi în Ghidul bazelor de date (Database Guide).

Crearea subformularelor

Şi aceasta este dincolo de scopul acestui document. Crearea subformularelor va fi descrisă în 
Ghidul bazelor de date (Database Guide).

Crearea pe baza mai multor tabele
În fereastra principală a bazei de date (Information – OpenOffice.org Base), apăsaţi pe 
pictograma Tabel (Table) pentru a o selecta. În secţiunea Activităţi (Task), sunt 3 pictograme. 
Primele două le-am folosit pentru a crea tabele. Cea de a treia este denumită Creare vizualizare 
(Create View). Apăsând pe aceasta se va deschide View1 – OpenOffice.org View Design. Deşi 
are un nume diferit, funcţiile sale şi aspectul sunt similare ca la crearea unei interogări folosind 
Modul Concepţie (Design View).

Interogările pot fi create din această fereastră urmând instrucţiunile din “Crearea interogărilor” 
de la pagina 23. Vă sfătuiesc să citiţi înainte întreaga secţiune despre crearea acestora.

Puteţi de asemenea crea din aceasta fereastră tabele care sunt o combinaţie de tabele deja 
existente. Din moment ce paşii sunt aceiaşi ca cei utilizaţi atunci când creaţi o interogare în 
modul Concepţie, aveţi răbdare până terminaţi de citit toată secţiunea despre crearea 
interogărilor.

Pentru a crea un asfel de tabel urmaţi primii 3 paşi din “Utilizarea modului Concepţie (Design
View) pentru crearea unei interogări” de la pagina 27. La sfârşitul pasului 3, o referinţă 
încrucişată vă va îndruma din nou la această secţiune. Salvaţi tabelul cu orice nume doriţi şi 
apoi închideţi fereastra.

Accesarea altor surse de date

OpenOffice.org permite ca sursele de date să fie accesate şi apoi legate în documentele OOo. 
De exemplu, puteţi lega un document extern conţinând o listă de nume şi adrese de email cu o 
scrisoare (mail merge - concatenare de email), rezultând câte o copie a scrisorii pentru fiecare 
înregistrare din acea listă.

În OpenOffice.org 1.x, opţiunea Unelte > Surse de date (Tools > Data Sources) 
permitea ca o nouă sursă de date (sau bază de date) să fie înregistrată astfel încât orice 
componentă OOo să o poată accesa şi folosi. Această opţiune nu mai există în OOo 
v2. 

Pentru a înregistra o sursă de date, selectaţi Fişier > Nou > Bază de date (File > New 
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> Database), selectaţi Conectare la o bază de date existentă (Connect to an 
existing database), şi apoi selectaţi tipul sursei de date la care vă conectaţi. Apoi 
alegeţi sursa respectivă în cadrul vrăjitorului.

După ce a fost înregistrată o sursă de date, aceasta poate fi folosită în orice componenta OOo 
(de exemplu în Writer sau Calc) selectând Vizualizare > Surse de date (View > Data 
Sources) sau prin apăsarea tastei F4. 

PONT Mozilla Address Books (cărţile de adrese Mozzile) şi bazele de date dBase (printre 
altele) pot fi accesate, iar noi înregistrări pot fi adăugate sau modificate. Foile de 
calcul pot fi accesate dar nu le puteţi modifica conţinutul.

Accesarea unei baze de date dBase
1) Fişier > Nou > Bază de date (File > New > Database) va deschide fereastra Vrăjitor 

de baze de date (Database Wizard). 

Notă Apăsând pe pictograma Nou (New) şi alegând din meniul contextual Bază de date  
(Database) va deschide tot fereastra Vrăjitor de baze de date. (Vedeţi Imaginea 1.)

2) Selectaţi Conectare la o bază de date existentă (Connecting to an existing 
database). Apăsarea tastei TAB selectează lista derulantă Tipul bazei de date 
(Database). Tastând D selectaţi dBase. Apăsaţi Next. 

Notă Clicking the arrows opens a menu from which you can select dBase (Imaginea 17).

Imaginea 17: Selectarea tipului bazei de date

3) Apăsaţi Răsfoire (Browse) şi selectaţi directorul care conţine baza de date. Apăsaţi 
Următorul (Next).

4) Acceptaţi paşii propuşi: înregistrează baza de date pentru mine (register the database 
for me), şi deschide baza de date pentru editare (open the database for editing). Apăsaţi 
Finalizare (Finish). Denumiţi şi salvaţi baza de date unde doriţi.

5) Creaţi un formular folosind Vrăjitorul de formulare (Form Wizard) după cum am 
explicat în “Crearea unui formular pentru baza de date” de la pagina 11.

Accesarea c r ii de adrese Mozillaă ţ
Accesarea cărţii de adrese Mozilla (Mozilla Address Book) este similară cu accesarea unei 
baze de date dBase. 
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1) Selectaţi Fişier > Nou > Bază de date (File > New > Database). 

2) Selectaţi Conectare la o bază de date existentă (Connect to an existing database). 
Selectaţi Carte de adrese Mozilla (M. Address Book) ca tip de bază de date (Imaginea
17).

3) Înregistraţi această sursă de date. 

Aceştia sunt paşii 1, 2 şi 4 din Accesarea unei baze de date dBase de mai sus.

Accesarea foilor de calcul
Accesarea unei foi de calcul este de asemenea similară cu accesarea unei baze de date dBase. 

1) Selectaţi Fisier > Nou > Bază de date (File > New > Database).

2) Selectaţi Conectare la o bază de date existentă (Connect to an existing database). 
Selectaţi Foaie de calcul (Spreadsheet) ca tip de bază de date (Imaginea 17).

3) Apăsaţi Răsfoire (Browse) pentru a localiza foaia de calcul pe care doriţi să o accesaţi. 
Dacă aceasta este protejată prin parolă bifaţi căsuţa Parolă necesară (Password 
required). Apăsaţi Următorul (Next).

4) Dacă baza de date necesită un nume de utilizator, introduceţi-l. Dacă trebuie introdusă şi 
o parolă, bifaţi căsuţa corespunzătoare. Apăsaţi Următorul (Next).

Înregistrarea bazelor de date create de OOo v. 2.0
Este o procedură simplă. Unelte > Opţiuni > OpenOffice.org Base > Baze de date (Tools > 
Options > OpenOffice.org Base > Databases). Sub Baze de date înregistrate (Registered 
databases) este o listă a acestora. Sub această listă sunt trei butoane: Nou (New), Şterge 
(Delete), Editare (Edit). Pentru a înregistra o baza de date creată de OpenOffice.org v. 2.0:

1) Apăsaţi Nou (New).

2) Răsfoiţi (Browse) pentru a localiza baza de date.

3) Asiguraţi-vă că numele sub care o înregistraţi este corect. 

4) Apăsaţi OK.

Folosirea surselor de date în OpenOffice.org

Având acum înregistrată sursa de date, fie că este o foaie de calcul, un document text, o bază 
de date externă sau altă sursă de date acceptată, o puteţi folosi în alte componente 
OpenOffice.org inclusiv în Writer şi Calc.
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Vizualizarea surselor de date
Deschideţi un document în Writer sau Calc. Pentru a vizualiza sursele de date disponibile, 
apăsaţi F4 sau selectaţi Vizualizare > Surse de date (View > Data Sources) din meniul 
derulant. Aceasta va afişa o listă cu bazele de date înregistrate, care includ Bibiliografia 
(Bibliography) printre toate celelalte baze de date înregistrate.

Pentru a vizualiza fiecare bază de date, apăsaţi pe + de la stânga numelui acesteia. (Aceasta a 
fost deja făcut pentru baza de date Information în Imaginea 18.) Aceasta va declanşa Tabele şi 
interogări (Tables and Queries). Apăsaţi pe semnul + de lângă Tabele (Tables) pentru a 
vizualiza tabelele individuale care au fost create. Acum daţi dublu clic pe un tabel pentru a 
vizualiza toate înregistrările pe care le conţine.

Imaginea 18: Baze de date

Editarea surselor de date
Unele surse de date pot fi editate în dialogul Vizualizare surse de date (View Data Sources). 
Nu pot fi editate foile de calcul. O înregistrare poate fi editată, adaugată sau ştearsă.

Datele sunt afişate în partea dreaptă a ecranului. Daţi clic într-un câmp pentru a-i edita 
valoarea.

Sub înregistrări sunt cinci butoane micuţe. Primele patru mută cursorul înapoi sau înainte în 
baza de date, ori la începutul sau sfârşitul acesteia. Cel de al cincilea buton, cu o stea micuţă, 
inserează o nouă înregistrare. (Imaginea 19).

Imaginea 19: Butoanele de navigare din Vizualizare surse de date

Pentru a şterge o înregistrare, daţi clic dreapta pe căsuţa gri de la stânga unui rând pentru a 
selecta întregul rând şi apoi selectaţi Şterge rânduri (Delete Rows) pentru a elimina rândul 
selectat.
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Pornirea Base pentru lucrul la sursele de date
Puteţi oricând lansa OOo Base din panoul Vizualizare suese de date (View Data Source). 
Trebuie doar să dati clic dreapta pe o bază de date sau pe pictogramele Tabele sau interogări 
(Tables or Queries) şi să selectaţi Editare fişier bază de date (Edit Database File). Din Base 
puteţi să editaţi, să adăugaţi sau să ştergeţi tabele, înregistrări, formulare şi rapoarte.

Folosirea surselor de date în documentele OOo
Pentru a insera un câmp dintr-un tabel într-un document (de exemplu într-o foaie de calcul 
Calc sau document Writer), apăsaţi pe numele câmpului (pătrăţelul gri din partea de sus a listei 
câmpurilor) şi, ţinând apăsat butonul stâng al mausului, trageţi câmpul în document. Într-un 
document Writer, va fi afişat ca  <FIELD> (unde FIELD este numele câmpului pe care l-aţi 
tras). În Calc va fi afişat ca o căsuţă de text.

O utilizare comună a unei surse de date este să efectuaţi o concatenare de email. Selectaţi 
Unelte > Vrăjitor concatenare scrisori (Tools > Mail Merge Wizard) sau apăsaţi pe 
pictograma Concatenare scrisori (Mail Merge - este o mică pictogramă cu o foaie şi un plic în 
panoul Vizualizare surse de date - View Data Source) pentru a porni Vrăjitorul de concatenare 
scrisori OpenOffice.org, care vă va conduce prin paşii creării unui document care concatenează 
scrisorile. Aceasta este descrisă în capitolul “Using Mail Merge (Folosirea concatenării 
scrisorilor)” din Ghidul Writer (Writer Guide).

Introducerea de date într-un formular

Înregistrările (Records) sunt folosite pentru a organiza datele pe care le introducem într-un 
formular. Vom introduce toate datele despre fiecare persoană pe care o dorim a figura în baza 
noastră de date. La apăsarea tastei Tab ce am completat ultimul câmp din formular pentru o 
persoană, toate câmpurile vor fi şterse - cu posibila excepţie a câmpului AddressID. Vom fi 
finalizat de completat prima înregistrare din formularul Acquaintance Addressees (Adresele 
cunoştinţelor) din baza noastră de date. De fiecare dată când vom face aceasta vom adauga o 
nouă înregistrare. (De exemplu, înregistrarea din Imaginea 20. Dacă cursorul este în câmpul 
EmailAddress, apăsarea tastei Tab şterg toate câmpurile din formular cu excepţia câmpului 
AddressID. Numărul din căsuţa din partea de jos - stânga se va modifica din numărul 1 în 
numarul 2.)

În partea de jos a formularului este cuvântul Înregistrare (Record). După el sunt nişte 
informaţii despre ce înregistrare este afişată şi cât de multe înregistrări există. În acest caz, se 
afişează înregistrarea 1 din cele 3 existente. La dreapta acestor informaţii sutn pictograme 
suplimentare care vă permit să vă deplasaţi de la o înregistare la alta (săgeţile), să adăugati o 
nouă înregistrare, să ştergeţi una din înregistrări şi altele.

Scopul unei baze de date este sa stocheze informaţiile într-o modalitate care să permită să fie 
accesate mai târziu, când este nevoie de ele. Aceasta secţiune descrie cum să introduceţi date 
astfel încât sa le folosiţi mai târziu. Trebui să fiţi în fereastra Information – OpenOffice.org 
Base. În exemplul nostru vom introduce date în formularul Acquaintance Information 
(Informaţii despre cunoştinţe). Adăugarea de date în celelalte formulare este similară.

Ini iere în Baseţ 21



 CIORN  – bazat  pe software nefinalizatĂ ă Introducerea de date într-un formular

Imaginea 20: O înregistrare individuală

Dacă nu doriţi să utilizaţi date reale în acest formular, folosiţi următoarele informaţii pentru 
cinci familii fictive. Fiecare câmp este separat prin punct si virgulă (;). În cazul în care câmpul 
ID conţine <AutoField>, începeţi să introduceţi datele de la câmpul FirstName (Nume de 
familie). Altfel, introduceţi numerele în câmpul ID: numărul 1 la prima înregistrare, numărul 2 
la a doua şi tot aşa până la numărul 5 pentru cea de a cincea înregistrare. (Nu toate 
înregistrările vor avea toate câmpurile completate. De exemplu, Sam & Alice nu au copii.)

1; Sam; Spade; Alice ; Aug.; 22; 2000; Apr.; 1; 1980; Mai; 31; 1982

2; Billy; Appleseed; Ruth; Iul.; 4; 1996; Dec.; 25; 1974;  Ian.; 1; 1975; Chad; Feb.; 2; 1998

3; Junior; Salesman; Deloris; Iul.; 31; 1992; Apr.; 1; 1973; Sep.; 22; 1975; Samantha; Ian.; 5; 
1993

4; Jamie; Spencer; Alice;  Ian.; 1; 2004; Apr.; 22; 1985; Iun.; 15; 1985

5; Webster; Callahan; Betty; Noi.; 22; 1990; Aug.; 16; 1968; Dec.; 25; 1970; Ed; Ian.; 10; 1991

1) Dacă pictograma Formulare (Forms) din stânga nu este selectată, selectaţi-o fie apăsând 
pe pictogramă fie tastând Alt+m. Daţi dublu clic pe pictograma Acquaintance 
Information.

2) Câmpul ID:

• Dacă <AutoField> nu este prezent în câmpul ID daţi clic în acest câmp şi 
introduceţi un număr. (Sugestie: introduceţi 1.) Apoi apăsaţi tasta Tab.

• Dacă <AutoField> este prezent daţi clic direct în câmpul FirstName.

3) Pentru celelalte câmpuri din formular, începând cu FirstName:

• Dacă un câmp ar trebui să fie gol, apăsaţi tasta Tab pentru a trece la câmpul 
următor.

• Altfel, introduceţi datele şi apăsaţi tasta Tab pentru a trece la câmpul următor.
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• Pentru a muta cursorul în sens invers între câmpuri folosiţi tastele Shift+Tab.

• Apăsarea tastei Tab din ultimul câmp introduce toate datele din formular în baza de 
date (salvează înregistrarea) şi începe editarea următoarei înregistrări. (Shift+Tab 
cât timp cursorul este în primul câmp dintr-o înregistrare salvează datele din 
formular în baza de date şi va muta cursorul în ultimul câmp din înregistrarea 
precedentă. Aceasta este valabil de la a doua înregistrare încolo.)

4) Când veţi fi introdus toate datele necesare, închideţi fereastra Acquaintance Information 
– OpenOffice.org Writer.

Întroducerea datelor în formularul Acquaintance Addresses (Adresele cunoştinţelor) este 
similară. Observaţi că primele 3 câmpuri din acest formular sunt aceleaşi ca şi cele din 
Acquaintance Information. Introduceţi restul datelor după cum este necesar urmând aceiaşi paşi 
ca şi pentru formularul Acquaintance Information. 

Crearea interog riloră

Interogările sunt folosite pentru a extrage informaţii precizate (prin criterii) dintr-o bază de 
date. În baza de date din exemplul nostru, o interogare simplă ar putea crea o listă cu toate 
aniversările nunţilor dintr-o anumită lună. Vom face aceasta folosind un vrăjitor. O interogare 
mai complexă ar fi să creem o lista a tuturor aniversărilor de zile de naştere dintr-o anumită 
lună. Vom face aceasta folosinf modul Concepţie (Design View). Vom crea o interogare pentru 
a căuta tabelele din Acquaintance Addresses Information pentru toate aniversările din iulie şi 
adresele familiilor respective. Această interogare va include următoarele informaţii: 
FirstName, LastName, SpouseName, Address, City, StateOrProvince, PostalCode, 
CountryOrRegion, şi data căsătoriei (lunăm zi, an). În acest mod vom putea afla cine îşi 
aniversează  ziua căsătoriei în iulie, în care zi din iulie are loc, şi adresa soţilor pentru a le 
putea trimite o felicitare.

Notă Interogările estompează diferenţele dintre o bază de date şi o sursă de date. O bază de 
date reprezintă numai un singur tip de sursă de date. Cu toate acestea, căutarea pentru 
informaţiile cerute într-o sursă de date necesită o interogare. Această interogare este 
însă parte a unei baze de date, astfel încât sursa de date apare ca făcând parte din baza 
de date, ca unul sau mai multe tabele. Rezultatele interogărilor sunt tabele speciale 
din baza de date.

Folosirea Vr jitorului pentru a crea o interogareă
Asiguraţi-vă că sunteţi în fereastra Information – OpenOffice.org Base. Apăsaţi pictograma 
Interogări (Queries) pentru a o selecta. În secţiunea Activităţi (Task) din această fereastră daţi 
dublu clic pe pictograma Foloseşte Vrăjitorul pentru a crea interogare (Use Wizard to create 
Query). Aceasta va deschide fereastra Vrăjitorului de interogări (Imaginea 21).

Notă Când lucraţi cu o interogare puteţi folosi mai mult de un tabel. Din moment ce tabele 
diferite pot conţine denumiri de câmpuri identice, formatul pentru referirea 
câmpurilor dintr-o interogare este numele tabelului şi numele câmpului. Un punct (.) 
desparte numele tabelului de numele câmpului. În exemplul nostru, numele tabelului 
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este compus din două cuvinte, astfel încât punctul urmează dupa cel de al doilea 
cuvânt din numele tabelului şi înainte de numele câmpului. (De exemplu, câmpul 
FirstName din tabelul Acquaintance Addressees este denumit Acquaintance 
Addressees.FirstName. Câmpul FirstName din tabelul Acquaintance Information eset 
denumit Acquaintance Information.FirstName.)

Imaginea 21: Prima pagină a Vrăjitorului de interogări (Query Wizard)

Pasul 1: Selectaţi câmpurile.

1) Din moment ce majoritatea informaţiilor pe care le dorim sunt în Acquaintance 
Addresses, asiguraţi-vă că acest tabel este listat sub Tabele (Tables). Toate câmpurile 
din tabelul Acquaintance Addresses sunt listate în fereastra Câmpuri disponibile 
(Available fields).

Folosind săgeata (>), mutaţi aceste Câmpuri disponibile în fereastra Câmpuri din 
interogare (Fields in the Query): Acquaintance Addressees.FirstName, 
Acquaintance Addresses.LastName, Acquaintance Addressees.SpouseName, 
Acquaintance Addresses.Address, Acquaintance Addresses.City, Acquaintance 
Addresses.StateOrProvince, Acquaintance Addresses.PostalCode şi Acquaintance 
Addressees.CountryOrRegion.

2) Schimbaţi intrarea derulantă Tabele din Acquaintance Addresses în Acquaintance 
Information.
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Folosind săgeata (>), mutaţi aceste Câmpuri disponibile în fereastra Câmpuri din 
interogare: Acquaintance Information.WedDateM, Acquaintance 
Information.WedDateD şi Acquaintance Information.WedDateY. Aceste trei câmpuri 
vor apare dedesubtul câmpului Acquaintance Addressees.CountryOrRegion.

3) Apăsaţi Următorul (Next).

Pasul 2: Selectarea ordinii (de sortare).

Până la patru câmpuri pot fi folosite pentru a sorta informaţiile din interogarea noastră. Un pic 
de logică elementară ne va ajuta aici. Care câmp este cel mai important? Vă sugerez să alegeţi 
în primul rând ziua (nunţii, WedDateD). Apoi va putea urma LastName, iar pe al treilea loc ar 
putea fi FirstName sau SpouseName. Dacă doriţi să alegeţi alte câmpuri însă, sunteţi liberi să o 
faceţi.

1) În lista derulantă de sub Sortează după (Sort by), selectaţi Acquaintance 
Information.WedDateD.

2) În lista derulantă de sub primul Şi apoi prin (Then by), selectaţi Acquaintance 
Addresses.LastName.

3) În lista derulantă de sub al doilea Şi apoi prin (Then by), selectaţi Acquaintance 
Addresses.FirstName.

4) Apăsaţi Următorul (Next).

Pasul 3: Selectaţi condiţiile de căutare.

1) Din moment ce noi căutăm informaţii într-un singur câmp, presetarea de Potrivire 
după toate (Match all of the following) va funcţiona. 

Notă Potrivire după toate poate fi folosită într-o interogare care caută toate zilele de 
naştere din aprilie de exemplu. This will be done in the next section: Create a report 
using the Design View.

2) Selectaţi Acquaintance Information.WedDateM de la începutul listei derulante 
Câmpuri (Fields). Stabiliţi condiţia este egal cu (is equal to). Introduceţi 7 ca 
valoare. (Iulie este a şaptea lună din anul calendaristic.) Apăsaţi Următorul (Next) 
din partea de jos a ferestrei.

Pasul 4: Selectaţi tipul interogării.

Dorim simple informaţii, astfel încât opţiunea prestabilită: Interogare detaliată (Detailed 
query) este ceea ce dorim. Apăsaţi Următorul (Next) din partea de jos a ferestrei.

Notă Din moment ce dorim o interogare simplă, condiţiile Grupare (Grouping) şi Condiţii 
de grupare (Grouping conditions) nu sunt necesare. Aceşti doi paşi sunt săriţi în 
interogarea noastră.

Pasul 5: Asociaţi alte nume (aliasuri) dacă doriţi.

Dorim setările prestabilite. Apăsaţi Următorul (Next) din partea de jos a ferestrei.

Pasul 6: Vedere de ansamblu.
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Denumiţi interogarea (sugestie: Query_Weddings). La dreapta acesteia sunt două 
opţiuni.Selectaţi Modifică interogarea (Modify Query). Apăsaţi Finalizare (Finish).

Step 7: Modificarea interogării.

Se deschide fereastra Query_Weddings. Tabelele folosite în interogarea noastră sunt aratate în 
Imaginea 22. Dorim să legam aceste două tabele astfel încât să se comporte ca unul singur.

Imaginea 22: Tabelele folosite în interogare

Dacă cele două tabele nu sunt legate, primele trei coloane arată ca în Imaginea 23. Sunt listate 
toate înregistrările din primul tabel.

Imaginea 23: Rezultatele interogării cu tabele nelegate

Pentru a lega cele două tabele, apăsaţi pe câmpul AddressID din tabelul Acquaintance 
Addressees (Imaginea 22)  şi trageţi cu mausul cursorul până la câmpul ID din tabelul 
Acquaintance Information din Imaginea 22. O linie va apare conectând câmpurile AddressID şi 
ID. 

După ce am legat cele două tabele, putem rula din nou interogarea. Pentru a face aceasta, 
apăsaţi pictograma Rulează interogarea (Run Query). (Este cea cu o bifă verde din Imaginea
24.) Primele trei coloane ale rezultatului dunt în Imaginea 25. Două cupluri s-au căsătorit în 
iulie, şi numai acestea două sunt listate când folosim tabele legate.

Imaginea 24: Pictograma Rulează interogarea (Run Query)
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Imaginea 25: Rezultatele interogării cu tabele legate

Notă Când editaţi o interogare puteţi să modificaţi mărimea şi poziţia tabelelor.Apăsaţi şi 
trageţi cu mausul pe capul tabelului pentry a-l muta. Poziţionarea cursorului pe o 
margine îl preschimbă într-o săgeată dublă; modificaţi mărimea tabelului similar cu a 
unei ferestre.

PONT Editând Query_Weddings putem obţine o listă de aniversări pentru fiecare lună dată. 
În fereastra Information – OpenOffice.org Base, selectaţi Interogări (Queries). Daţi 
clic dreapta pe pictograma Query_Weddings şi selectaţi Edit(are) din meniul 
contextual. În fereastra Query_Weddings înlocuiţi '7' cu numărul oricărei luni doriţi. 
(7-le este în rândul Criteriu - Criterion şi coloana WedDateM.) Asiguraţi-vă că puneţi 
un apostrof înainte şi după număr. Apoi rulaţi din nou interogarea. (Imaginea 24).

Puteţi crea un formular pentru interogarea Query_Weddings. Daţi clic dreapta pe 
pictograma Query_Weddings şi selectaţi Vrăjitorul de formulare (Form Wizard) 
din meniul contextual. Vedeţi “Crearea unui formular pentru baza de date” la pagina 
11 pentru informaţii.

Utilizarea modului Concep ie (Design View) pentruţ  
crearea unei interog riă
Crearea unei interogări folosind modul Concepţie este nu este atât de greu cum ar putea să 
pară. Pentru interogarea noastră dorim să ştim cine s-a născut în august. Mergeţi la secţiunea 
Activităţi (Task) din fereastra Information – OpenOffice.org Base. Selectaţi Creează interogare 
în modul Concepţie (Create Query in Design View). Se vor deschide ferestrele Query1 – 
OpenOffice.org Query Design şi Add Table.

Pasul 1: Adăugaţi tabelele.

1) Apăsaţi pe Acquaintance Addressees, şi apoi pe Adaugă (Add).

2) Apăsaţi pe Acquaintance Information, şi apoi pe Adaugă (Add.

3) Apăsaţi Închide (Close).

Aceasta va deschide aceste două tabele. (Vedeţi Imaginea 22.)

Pasul 2: Legaţi cele două tabele.

Apăsaţi pe AddressID din tabelul Acquaintance Addresses şi trageţi cursorul mausului pe 
câmpul Id din tabelul Acquaintance Information. Un segment de linie va marca legătura dintre 
cele două câmpuri.

Pasul 3: Completaţi numele câmpurilor din interogare.
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Daţi dublu clic pe câmpurile pe care doriţi să le folosiţi, în ordinea în care doriţi să o faceţi. 
Unele dintre câmpuri vor proveni din tabelul Acquaintance Information. Dacă din greşeală aţi 
pus un câmp dezordonat, apăsaţi pe dreptunghiul gri de deasupra acelui câmp şi trageţi 
întreaga sa coloană în poziţia corectă.

1) Din tabelul Acquaintance Addressees daţi dublu clic pe aceste câmpuri în această 
ordine: FirstName, LastName, SpouseName.

2) Din tabelul Acquaintance Information daţi dublu clic pe aceste câmpuri în această 
ordine: HisBDM, HisBDD, HisBDY, HerBDM, HerBDD, HerBDY, Ch1, Ch1BDM, 
Ch1BDD, and Ch1BDY.

3) Din tabelul Acquaintance Addressees daţi dublu clic pe aceste câmpuri în această 
ordine: Address, City, StateOrProvince, PostalCode, CountryOrRegion.

PONT Paşii de mai sus pot fi folosiţi şi pentru a crea un singur tabel pe baza câmpurilor din 
două sau mai multe tabele. Dacă veţi dori să faceţi aceasta reîntoarceţi-vă la “Crearea
pe baza mai multor tabele” de la pagina 17. Altminteri ignoraţi acest pont.

Pasul 4: Introduceţi criteriile pentru interogare.

Introducem informaţia pe care dorim să o căutăm în rândul Criteriu (Criterion) din cadrul 
interogării (Imaginea 26). Modul în care formulăm aceste condiţii determină ce rezultate vom 
avea. Dacă dorim ca anumite câmpuri să îndeplinească criteriile simultan, vom scrie aceste 
criterii pe rândul Criterii. Aceasta este aşa-numita condiţie Şi (And). Criteriile le veţi scrie 
fiecare în coloana corespunzătoare câmpului, în cadrul rândului Criterii.

În exemplul nostru, căutăm familiile în care cel puţin un membru îşi sărbătoreşte ziua de 
naştere în august. Aceasta este o condiţie Sau (Or). (Soţul Sau soţia Sau copilul s-au născut în 
august.)

Notă Completa utilizare a criteriile disponibile dintr-o interogare necesită cunoştinţe 
matematice şi de operaţii cu mulţimi (uniuni, intersecţii, complement, combinaţii de 
acestea). 

Imaginea 26: Tabelul de definire a interogării
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1) Toate elementele pe care le introduceţi în tabelul de definire a interogării trebuie să 
fie de forma: 'element' (adică un apostrof, textul, alt apostrof). 

2) Din moment ce august este a opta lună a anului, un 8 va fi introdus în câmp. În 
Imaginea 26, cele patru rânduri de sub rândul Criterii sunt etichetate Sau (Or). Când 
există un criteriu într-o coloană din cadrul rândului Criterii şi într-o altă coloană 
dinprimul rând Sau (Or), este efectuată o căutare pentru toate înregistrările care se 
potrivesc fie cu criteriul din rândul Criterii fie cu cel din rândul Sau.

3) Câmpurile care ne interesează sunt HisBDM, HerBDM şi Ch1BDM.

• În rândul Criterii şi coloana HisBDM introducem '8' (apostrof 8 apostrof).

• În primul rând Sau şi coloana HerBDM introducem '8'.

• În al doilea rând Sau şi coloana Ch1BDM introducem '8'. 

• Rezultatele ar trebui să arate cam ca în Imaginea 27. (Imaginea nu arată 
câmpurile FirstName, LastName şi SpouseName. Tabelul dumneavoastră va 
avea aceste trei câmpuri între coloana ce conţine etichetele rândurilor şi coloana 
HisBDM.) 

Imaginea 27: Folosind condiţia Sau (Or) între trei câmpuri

4) Apăsaţi pictograma Rulează interogarea (Run Query) (Imaginea 24 de la pagina 26).

5) Salvaţi interogarea sub numele de Query_Birthdays şi închideţi fereastra.

PONT Această interogare poate fi folosită pentru a regăsi ce persoane au ziua de naştere în 
anumite luni. Schimbaţi 8-ul în numărul corespunzător altei luni. Asiguraţi-vă că un 
apostrof este înainte şi altul după acest număr.
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Crearea rapoartelor

Rapoartele furnizează informaţia conţinută de baza de date într-o formatare folositoare. Din 
acest punct de vedere ele sunt similare cu interogările. Rapoartele sunt generate pe baza 
tabelelor şi interogărilor din baza de date. Ele pot conţine toate câmpurile bazei de date sau 
numai unele. Rapoartele pot fi statice sau dinamice. Cele statice conţin datele din câmpurile 
selectate la momentul creării raportului, pe când cele dinamice pot fi actualizate pentru a arăta 
ultimele informaţii din baza de date. 

Vom crea un raport dinamic al aniversărilor nunţilor dintr-o anumită lună. Interogarea 
Query_Weddings (Interogare_nunţi) va fi baza raportului nostru: Monthly Wedding 
Anniversaries (Aniversări lunare ale nunţilor). Editaţi interogarea pentru a se potrivi cu luna pe 
care o vom căuta şi când veţi salva modificările interogării raportul se va actualiza simultan.

Pasul 1: Accesarea vrăjitorului de rapoarte în unul din cele două moduri. 

• Apăsaţi pe pictograma Rapoarte (Reports) din fereastra Information – OpenOffice.org 
Base, şi apăsaţi pe Foloseşte Vrăjitorul pentru a crea un raport (Use Wizard to Create 
Report).

sau

• Daţi dubluc clic pe un raport sau un tabel şi selectaţi Vrăjitorul de rapoarte (Report 
Wizard) din meniul contextual.

Imaginea 28. Prima pagină din Vrăjitorul de rapoarte (Report Wizard)
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Pasul 2: Vrăjitorul de rapoarte (Imaginea 28).

1) În lista derulantă Tabele sau interogări (Tables or Queries) selectaţi Interogare 
(Query): Query_Weddings.

• Folosiţi săgeata dublă (>>) pentru a muta toate câmpurile din rubrica Câmpuri 
disponibile (Available fields) în Câmpuri din raport (Fields in report).

• Apăsaţi Următorul (Next).

2) Schimbaţi etichetele pentru o parte din câmpuri.

• Pentru etichete care conţin mai mult de un cuvânt puneţi un spaţiu între cuvinte. 
(De exemplu, FirstName devine First Name, LastName devine Last Name iar 
CountryOrRegion devine Country Or Region.)

• Schimbaţi PostalCode în Postal Code, WedDateM în Month, WedDateD în Date 
şi WedDateY în Year.

• Apăsaţi Următorul (Next).

3) Gruparea. Vom grupa elementele din acest raport după câmpul LastName. 

• Apăsaţi pe LastName din lista Câmpuri (Fields) şi folosiţi săgeata (>) pentru a o 
muta în lista Grupări (Groupings).

• Apăsaţi Următorul (Next).

4) Aspectul raportului: Vom folosi setările obişnuite. Aceasta include orientare Portret 
(Landscape) în partea de jos a Vrăjitorului de rapoarte. Apăsaţi Următorul (Next).

Notă Probabil ar merita să petreceţi câtva timp selectând câte una din diferitele opţiuni de 
aspect disponibile în rapoarte pentru a vedea care este cea mai potrivită pentru 
dumneavoastră.

5) Crearea raportului: 

• Denumiţi raportul Query_Weddings.

• Ce fel de raport doriţi să creaţi? Selectaţi Dynamic.

• Ce doriţi să faceţi după ce creaţi raportul? Selectaţi Modifică aspectul raportului 
(Modify report layout).

• Apăsaţi Finalizare (Finish).

6) Modificarea raportului. Acest raport conţine un tabel cu informaţia din interogare. S-
ar putea să conţină nişte cuvinte pe care nu le cunoaşteţi (Imaginea 29). Vom 
schimba alinierea verticală a celui de al doilea rând.

• Apăsaţi pe celula de sub eticheta First Name şi trageţi cursoul mausului la 
dreapta pentru a selecta cel de al doilea rând. 

• Daţi clic-dreapta oriunde într-o celulă selectată. Selectaţi Celulă > Centrat 
(Cell > Center) pentru a stabili alinierea corectă/dorită.

• Dacă doriţi, puteţi modifica lăţimile oricăreia dintre celule la acest pas.
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• Salvaţi (Save) şi Închideţi (Close) fereastra Query_Weddings – OpenOffice.org 
Writer.

Imaginea 29: Prima parte a tabelului Raport

Notă Rapoartele pot fi modificate din fereastra Information – OpenOffice.org Base dând 
clic-dreapta pe interogarea dorită şi selectând Edit(are) din meniul contextual.

PONT Dacă raportul este creat ca fiind dinamic şi este bazat pe o interogare, acesta va fi 
actualizat de fiecare data când se modifică interogarea. (De exemplu, puteţi modifica 
interogarea Query_Birthdays pentru a căuta luna aprilie în loc de august. Data 
următoare când veţi accesa raportul Query_Birthdays va lista informaţiile pentru 
persoanele născute în aprilie şi nu în august.)

Ini iere în Baseţ 32


	Copyright
	Autori
	Părerea dumneavoastră
	Mulţumiri
	Data publicării şi versiunea programului
	Introducere
	Crearea unei baze de date
	Crearea unei noi baze de date
	Crearea tabelelor din baza de date
	Folosirea Vrăjitorului pentru a crea un tabel
	Crearea tabelului prin copierea unui tabel existent
	Crearea tabelelor în modul Concepţie (Design View)
	Crearea tabelelor pentru liste

	Adăugarea datelor în tabelul listă
	Crearea unui formular pentru baza de date
	Folosirea Vrăjitorului pentru a crea formulare
	Folosirea Vrăjitorului pentru a crea formularele pentru informaţii
	Crearea formularelor în modul Concepţie (Design View)
	Crearea subformularelor

	Crearea pe baza mai multor tabele

	Accesarea altor surse de date
	Accesarea unei baze de date dBase
	Accesarea cărţii de adrese Mozilla
	Accesarea foilor de calcul
	Înregistrarea bazelor de date create de OOo v. 2.0

	Folosirea surselor de date în OpenOffice.org
	Vizualizarea surselor de date
	Editarea surselor de date
	Pornirea Base pentru lucrul la sursele de date
	Folosirea surselor de date în documentele OOo

	Introducerea de date într-un formular
	Crearea interogărilor
	Folosirea Vrăjitorului pentru a crea o interogare
	Utilizarea modului Concepţie (Design View) pentru crearea unei interogări

	Crearea rapoartelor

